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Safety Instructions • English

WARNING:	 This symbol, D, when used on the product, is intended 
to alert the user of the presence of uninsulated dangerous voltage 
within the product’s enclosure that may present a risk of electric shock.

ATTENTION:		 This symbol, I, when used on the product, is 
intended to alert the user of important operating and maintenance 
(servicing) instructions in the literature provided with the equipment.

For information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics, see the Extron Safety and 
Regulatory Compliance Guide, part number 68-290-01, on the Extron 
website, www.extron.com.

Instructions de sécurité • Français

avertissement:	 Ce pictogramme, D, lorsqu’il est utilisé sur 
le produit, signale à l’utilisateur la présence à l’intérieur du boîtier du 
produit d’une tension électrique dangereuse susceptible de provoquer 
un choc électrique.

attention:		 Ce pictogramme, I, lorsqu’il est utilisé sur le produit, 
signale à l’utilisateur des instructions d’utilisation ou de maintenance 
importantes qui se trouvent dans la documentation fournie avec le 
matériel.

Pour en savoir plus sur les règles de sécurité, la conformité à la 
réglementation, la compatibilité EMI/EMF, l’accessibilité, et autres sujets 
connexes, lisez les informations de sécurité et de conformité Extron,  
réf. 68-290-01, sur le site Extron, www.extron.fr.

Sicherheitsanweisungen • Deutsch

WARNUNG:	 	 Dieses Symbol D auf dem Produkt soll den Benutzer 
darauf aufmerksam machen, dass im Inneren des Gehäuses dieses 
Produktes gefährliche Spannungen herrschen, die nicht isoliert sind 
und die einen elektrischen Schlag verursachen können.

VORSICHT:	 Dieses Symbol I auf dem Produkt soll dem Benutzer 
in der im Lieferumfang enthaltenen Dokumentation besonders wichtige 
Hinweise zur Bedienung und Wartung (Instandhaltung) geben.

Weitere Informationen über die Sicherheitsrichtlinien, Produkthandhabung, 
EMI/EMF-Kompatibilität, Zugänglichkeit und verwandte Themen finden Sie 
in den Extron-Richtlinien für Sicherheit und Handhabung  (Artikelnummer 
68‑290-01) auf der Extron-Website, www.extron.de.

Instrucciones de seguridad • Español

ADVERTENCIA:	 Este símbolo, D, cuando se utiliza en el producto, 
avisa al usuario de la presencia de voltaje peligroso sin aislar dentro del 
producto, lo que puede representar un riesgo de descarga eléctrica.

ATENCIÓN:	 Este símbolo, I, cuando se utiliza en el producto, 
avisa al usuario de la presencia de importantes instrucciones de uso y 
mantenimiento recogidas en la documentación proporcionada con el 
equipo.

Para obtener información sobre directrices de seguridad, cumplimiento 
de normativas,  compatibilidad electromagnética, accesibilidad y temas 
relacionados, consulte la  Guía de cumplimiento de normativas y seguridad 
de Extron, referencia 68-290-01, en el sitio Web de Extron, www.extron.es.

Инструкция по технике безопасности • Русский

ПРЕДУПРЕЖДЕНИЕ:	 Данный символ, D, если указан 
на продукте, предупреждает пользователя о наличии 
неизолированного опасного напряжения внутри корпуса 
продукта, которое может привести к поражению электрическим 
током.

ВНИМАНИЕ: 	 Данный символ, I, если указан на продукте, 
предупреждает пользователя о наличии важных инструкций по 
эксплуатации и обслуживанию в руководстве, прилагаемом к 
данному оборудованию.

Для получения информации о правилах техники безопасности, 
соблюдении нормативных требований, электромагнитной 
совместимости (ЭМП/ЭДС), возможности доступа и других вопросах 
см. руководство по безопасности и соблюдению нормативных 
требований Extron на сайте Extron: www.extron.ru, номер по каталогу 
- 68-290-01.

Chinese Simplified（简体中文）

警告：D产品上的这个标志意在警告用户该产品机壳内有暴露的危险 

电压，有触电危险。

注意：I 产 品 上 的 这个 标 志 意在 提 示用 户设备 随 附 的用 户手 册 中 有 
重要的操作和维护(维修）说明。

关于我们产品的安全指南、遵循的规范、EMI/EMF 的兼容性、无障碍 
使用的特性等相关内容，敬请访问 Extron 网站 www.extron.cn，参见 Extron  
安全规范指南，产品编号 68-290-01。

Chinese Traditional（繁體中文）

警告: D若產品上使用此符號，是為了提醒使用者，產品機殼內存在著 

可能會導致觸電之風險的未絕緣危險電壓。

注意	I 若產品上使用此符號，是為了提醒使用者。

有關安全性指導方針、法規遵守、EMI/EMF 相容性、存取範圍和相關主題的詳細
資訊，請瀏覽 Extron 網站：www.extron.cn，然後參閱《Extron 安全性與法規遵
守手冊》，準則編號 68-290-01。

Japanese

警告: この記号 D  が 製 品上に表 示されている場合は、筐体内に絶 縁されて 
  いない高電圧が流れ、感電の危険があることを示しています。

注意: この記号 I が製品上に表示されている場合は、本機の取扱説明書に記載されて    
いる重要な操作と保守(整備)の指示についてユーザーの注意を喚起するものです。

安全上のご注意、法令遵守、EMI/EMF適合性、その他の関連項目に  
ついては、エクストロンのウェブサイトwww.extron.jpより 

『Extron Safety and Regulatory Compliance Guide』 (P/N 68-290-01) をご覧く
ださい。

Korean

경고:    이 기호 D, 가 제품에 사용될 경우, 제품의 인클로저 내에 있는 
접지되지 않은 위험한 전류로 인해 사용자가 감전될 위험이 있음을 
경고합니다.

주의:     이 기호 I, 가 제품에 사용될 경우, 장비와 함께 제공된 책자에 나와 
있는 주요 운영 및 유지보수(정비) 지침을 경고합니다.

안전 가이드라인, 규제 준수, EMI/EMF 호환성, 접근성, 그리고 관련 항목에 대한 
자세한 내용은 Extron 웹 사이트(www.extron.co.kr)의 Extron 안전 및 규제 준수 
안내서, 68-290-01 조항을 참조하십시오. 
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FCC Class A Notice

This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to part 15 of the FCC rules. The Class A limits provide reasonable 
protection against harmful interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate radio frequency energy and, 
if not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is 
likely to cause interference; the user must correct the interference at his own expense.

NOTE:	

•	 This unit was tested with shielded I/O cables on the peripheral devices. Shielded 
cables must be used to ensure compliance with FCC emissions limits.

•	 For more information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics, see the Extron Safety and 
Regulatory Compliance Guide on the Extron website.

Copyright
© 2013  Extron Electronics. All rights reserved.
Trademarks
All trademarks mentioned in this guide are the properties of their respective owners.
The following registered trademarks(®), registered service marks(SM), and trademarks(TM) are the property of 
RGB Systems, Inc. or Extron Electronics:

Registered Trademarks (®)

AVTrac, Cable Cubby, CrossPoint, eBUS, EDID Manager, EDID Minder, Extron, Flat Field, GlobalViewer, Hideaway, Inline, IP Intercom, IP 
Link, Key Minder, LockIt, MediaLink, PlenumVault, PoleVault, PowerCage, PURE3, Quantum, SoundField, SpeedMount, SpeedSwitch, 
System Integrator, TeamWork, TouchLink, V‑Lock, VersaTools, VN‑Matrix,  VoiceLift, WallVault, WindoWall, XTP, XTP Systems

Registered Service Mark(SM) :  S3 Service Support Solutions

Trademarks (™)

AAP, AFL (Accu-Rate Frame Lock), ADSP (Advanced Digital Sync Processing), AIS (Advanced Instruction Set), Auto‑Image, CDRS (Class D 
Ripple Suppression), DDSP (Digital Display Sync Processing), DMI (Dynamic Motion Interpolation), Driver Configurator, DSP Configurator, DSVP 
(Digital Sync Validation Processing), FastBite, FOXBOX, IP Intercom HelpDesk, MAAP, MicroDigital, ProDSP, QS-FPC (QuickSwitch Front Panel 
Controller), Scope‑Trigger, SIS, Simple Instruction Set, Skew‑Free, SpeedNav, Triple‑Action Switching, XTRA, ZipCaddy, ZipClip
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Conventions Used in this Guide
In this user guide, the following are used:

WARNING:	 A warning indicates a situation that has the potential to result in death 
or severe injury.

CAUTION:	 A caution indicates a situation that may result in minor injury.

ATTENTION:	 Attention indicates a situation that may damage or destroy the product 
or associated equipment.

NOTE:	 A note draws attention to important information.

TIP:	 A tip provides a suggestion to make working with the application easier.

Commands are written in the fonts shown here: 
^AR Merge Scene,,Op1 scene 1,1 ̂ B 51 ̂ W^C
[01] R 0004 00300 00400 00800 00600 [02] 35 [17] [03]

E X!*X1&*X2)*X2#*X2! CE}

NOTE:	 For commands and examples of computer or device responses mentioned 
in this guide, the character “0” is used for the number zero and “O” represents 
the capital letter “o”.

Computer responses and directory paths that do not have variables are written in the font 
shown here: 

Reply from 208.132.180.48: bytes=32 times=2ms TTL=32
C:\Program Files\Extron

Variables are written in slanted form as shown here:
ping xxx.xxx.xxx.xxx —t
SOH R Data STX Command ETB ETX

Selectable items, such as menu names, menu options, buttons, tabs, and field names are 
written in the font shown here:

From the File menu, select New.

Click the OK button.

Specifications Availability
Product specifications are available on the Extron website, www.extron.com.
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Introduction

This guide describes the function, installation, and operation of the TouchLink TLP 710MV 
and TLP 710 TV panels. The guide also provides information about optional accessories 
that are available from Extron for both panels.

Unless otherwise stated, the terms TLP 710 Series, TLP 710, and TouchLink touchpane 
refer to both models.

About the TLP 710MV and TLP 710TV
Each unit has a 7-inch widescreen display with a resolution of 800x480. The screen 
displays graphic objects and text, which are associated with user-defined functions. 
The touch overlay screen allows the user to initiate or activate functions by touching the 
objects on the screen. 

The screen layout is designed with the Extron GUI Configurator software. The functions 
are assigned to the screen objects with the Extron Global Configurator software. The 
user can define the graphics and the functions associated with those graphics, providing 
versatility and adaptability to the configuration and control of an AV system.

A motion sensor, light sensor, and a speaker provide sleep mode, auto dimming, and 
audible feedback.

The TLP 710MV can be wall or rack mounted.

The TLP 710TV can be placed on a desktop or VESA® mounted on a wall or furniture, 
using the Extron LPVM-1 kit.

Features
7- inch LCD screen — displays a range of graphic objects and text on a 800x480 pixel 
screen with 18-bit color depth.

Touch screen overlay —provides simple and intuitive control over a range of functions 
by touching the icons displayed on the screen.

Built-in MTP —a twisted pair receiver accepts either S-video or composite video signals 
over standard CAT 5-type cable.

GUI Configurator and Global Configurator Software — allow the user to design a 
custom graphical user interface (GUI) and associate a range of different functions with 
objects in that display. No programming knowledge is needed.

Easy configuration and flexibility — on-screen graphics and text, as well as the 
functions associated with them, can be easily changed to adapt the control panel to the 
evolving needs of the system, avoiding the need for additional control modules.

Ethernet connection — provides an inexpensive, easily installed cabling option for 
connecting products located anywhere else on the network.

Power over the Ethernet (PoE) — allows the touchpanel to receive power and control 
over a single CAT 5-type cable, eliminating the need for a local power supply - PoE 
injector included.

Compatible with the full range of Extron IP Link Pro control processors — allows 
easy integration into existing systems.

TLP 710MV and TLP 710TV • Introduction 1
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Figure 1.	 	TLP 710MV Application Diagram

Programmable LEDs — can be user-defined to provide feedback about various system 
states.

Light sensor — adjusts LCD screen backlighting to compensate for ambient lighting.

Motion sensor — When no motion is detected for a user-defined period of time, the unit 
enters sleep mode to conserve power. When a user approaches the screen, the panel 
detects motion and is reactivated.

Speaker — provides audible feedback in response to events triggered by the user and 
audio playback for video previews.

Multiple mounting options — The TLP 710MV can be wall-mounted, rack-mounted, or 
furniture‑mounted.

The TLP 710TV comes with a stand that allows it to stand on a desktop or be mounted 
on the optional Extron swivel mount adapter (SMA-1). If the stand is removed, the unit can 
be mounted on a wall or furniture using a VESA D 75mm mount kit.

Color options — The TLP 710MV is available in black or white.
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Requirements

Computer
For a complete list of the requirements for running GUI Configurator or Global 
Configurator, see the Extron web page for that software.

NOTE:	 Use Global Configurator 3.3 or a later version and GUI Configurator 1.3 or a 
later version to configure the TLP 710MV or TLP 710TV.

Other Hardware
An Extron IP Link control interface must also be connected to the same network domain 
as the TouchLink panel. Suggested models include:

•	 IPL T S Series (for example, IPL T S4)

•	 IPL 250

•	 IPL T CR48

•	 IPCP 505

See the Extron website (www.extron.com) for further information about these products.
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Panel Features

This section describes:

•	 TLP 710MV Front Panel Features and Operations

•	 TLP 710MV Rear Panel Features and Connections

•	 TLP 710TV Front Panel Features and Operations

•	 TLP 710TV Rear Panel Features and Connections

TLP 710MV Front Panel Features and Operations

Extron

4

1

2

3

4

5

6

7

Figure 2.	 	TLP 710MV Front Panel

a	 Motion sensor — is capped with a small Fresnel lens that focuses light onto the 
sensor. When no motion has been detected for a user-defined period of time, the 
unit enters sleep mode. When motion is detected by the sensor, the screen display is 
restored and active.

b	 Microphone — is located below the LCD screen.

c	 Speaker — one located under the screen, on the left side of the panel, provides 
audible feedback for the user.

d	 Programmable LEDs — one on each top corner can be programmed to provide 
system feedback. They light red or green and can blink or light solid in response to 
user-defined events.

e	 LCD screen — has a 800x480 resolution with a touch overlay. A graphical user 
interface, designed using the Extron GUI Configurator software, displays buttons, 
text, or icons on the screen (see page 24). These are configured for a range of user-
defined functions, using the Extron Global Configurator software (see page 29).
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f	 Connection status LED — is unlit during normal operation. Blinks red if the 
connection to the IP Link controller is lost.

g	 Bezel — removable with Extron removal tool (provided). Clips fit into attachment 
points on the front panel (see figure 4 below) and snap into place.

8

Figure 3.	 TLP 710MV Top View

h	 Light sensor — is on top of the display frame. The sensor monitors the level of 
ambient light and adjusts the screen brightness. The sensor can be viewed only from 
above the panel.

Reset Buttons and LED
The front bezel is removed by inserting the Extron removal tool into the slots on the top of 
the unit. Behind the bezel are two buttons and an LED.

10 11

12

9

Figure 4.	 	TLP 710MV Front Panel with the Bezel Removed

i	 Bezel attachment points

j	 Menu button — activates the on-screen menus for calibrating the unit (see 
page 14).

k	 Reset button — allows the unit to be reset in any of four different modes. For further 
information see Reset Modes on page 41.

l	 Reset LED — provides feedback about the reset status when the user presses the 
reset button. For further information see Reset Modes on page 41.
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TLP 710MV Rear Panel Features and Connections

Extron
13

16

14

15

Figure 5.	 TLP 710MV Rear Panel Features

m	 Power connector — Connect the 2-pole, 3.5 mm captive screw connector from the 
12 VDC, 1.0 A power supply (not provided) to the power supply socket on the rear 
panel. Ensure the connections have the correct polarity as shown below.

NOTES:

•	 Extron recommends using the Power over Ethernet power supply. The 12 VDC, 
1.0 A power supply should be used only for setup or troubleshooting.

•	 If both power supplies are connected to the TLP 710MV, the PoE power supply 
takes precedence.

 

Power Receptacle

Captive Screw Connector

AC Power Cord

Ground  
+12 VDC 

External 
Power Supply
(12 VDC, 1 A )

SECTION  A–A

RidgesSmooth

Power Supply
Output Cord

AA

3/16"
(5 mm) Max.

Figure 6.	 Power Supply Connection
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ATTENTION: 

•	 Always use a power supply supplied by or specified by Extron. Use of an 
unauthorized power supply voids all regulatory compliance certification and 
may cause damage to the supply and the end product.

•	 Unless otherwise stated, the AC/DC adapters are not suitable for use in air 
handling spaces or in wall cavities. The power supply is to be located within 
the same vicinity as the Extron AV processing equipment in an ordinary 
location, Pollution Degree 2, secured to the equipment rack within the 
dedicated closet, podium, or desk.

•	 The installation must always be in accordance with the applicable 
provisions of National Electrical Code ANSI/NFPA 70, article 75 and the 
Canadian Electrical Code part 1, section 16. The power supply shall not be 
permanently fixed to building structure or similar structure.

NOTES: 

•	 The length of the exposed wires in the stripping process is critical. The 
ideal length is 3/16 inches (5 mm). If the exposed portion is any longer, the 
exposed wires may touch, causing a short circuit between them. If it is any 
shorter, the wires can be easily pulled out, even if tightly fastened by the 
captive screws.

•	 Do not tin the wires. Tinned wire does not hold its shape and can become 
loose over time.

n	 MTP signal adjustments — Use a small screwdriver to adjust these three MTP 
signal variables: S-video luminance gain (VID/Y), S-video chrominance gain (C), 
and sharpness (S). For composite video signals, the gain is controlled by the VID/Y 
adjustment. Insert a small Phillips head screwdriver into the recess and turn clockwise 
to increase adjustment or counterclockwise to decrease.

o	 MTP input — A twisted pair cable, terminated with an RJ‑45 connector, provides 
video and audio input from an Extron MTP transmitter. The MTP port is in the top 
surface of the recessed area (see the arrow to the left in figure 5).

ATTENTION:	 Connect the MTP transmitter to the MTP socket and the network 
connector to the network socket. Although both use RJ-45 connectors, the 
MTP socket (on the left) must be connected to an MTP transmitter and the 
network socket (on the right) must be connected to a LAN. The wires on each 
connector use different voltages and inputting the wrong voltages into a socket 
will damage the TLP 710MV.

p	 Network LAN and Power over Ethernet connector — 
The TLP 710MV connects to a network using a twisted pair 
cable, terminated with an RJ‑45 connector. The LAN port is 
in the top surface of the recessed area (see the arrow to the right in figure 5).

The network port has two LEDs. The green LED lights steadily to indicate that the 
touchpanel is connected correctly to a network. The yellow LED flashes to indicate 
that data is being passed to or from the touchpanel.

An Extron IP Link control interface must also be connected to the same network 
domain. Suggested models are listed on page 3.

Use a straight-through Ethernet cable to connect the panel to a switch or router. Use 
a crossover cable to connect the panel directly to a computer.

LAN

Activity LED

Link LED

RJ-45 Port
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Extron recommends using a Power over Ethernet (PoE) power supply. Use a 
straight‑through Ethernet cable to connect the power supply to a switch or router. 
This cable carries network information from the switch or router to the power 
supply input. A second straight-through cable carries the network information and 
48 VDC from the power supply to the TLP 710MV. Connect the IEC power cord to a 
convenient 100 VAC to 240 VAC, 50-60 Hz power source.

PWR LAN-OUT LAN-IN

To Network SwitchTo TLP 710MV

Power over Ethernet (PoE) Power Supply

Figure 7.	 Connecting the Power over Ethernet Power Supply

ATTENTION:

•	 The TLP 710MV and TLP 710TV are intended for connection to a Power 
over Ethernet circuit for intra-building use only and are considered to be 
part of a Network Environment 0 per IEC TR62101.

•	 Always use a power supply supplied or specified by Extron. Use of an 
unauthorized power supply voids all regulatory compliance certification and 
may damage the supply and end product.

•	 Extron power supplies are certified to UL/CSA 60950-1 and are classified 
as LPS (Limited Power Source). Use of a non-LPS or unlisted power 
supply will void all regulatory compliance certification.

•	 Unless otherwise stated, the AC/DC adapters are not suitable for use in 
air handling spaces or in wall cavities. The power supply is to be located 
within the same vicinity as the Extron AV processing equipment in an 
ordinary location, Pollution Degree 2, secured to the equipment rack 
within the dedicated closet, podium or desk. Power over Ethernet (PoE) is 
intended for indoor use only. No part of the network that uses PoE can be 
routed outdoors.

•	 The installation must always be in accordance with the applicable 
provisions of National Electrical Code ANSI/NFPA 70, article 75 and the 
Canadian Electrical Code part 1, section 16. The power supply shall not be 
permanently fixed to building structure or similar structure.
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TLP 710TV Front Panel Features and Operations

Extron
a
b
c

d

e

f

d

Figure 8.	 TLP 710TV Front Panel Features

a	 Motion sensor —  is capped with a small Fresnel lens that focuses light onto the 
sensor. When no motion has been detected for a user-defined period of time, the 
unit enters sleep mode. When motion is detected by the sensor, the screen display is 
restored and active. 

b	 Microphone — is located below the LCD screen.

c	 Speaker — one located under the screen, on the left side of the panel, provides 
audible feedback for the user and audio for video previews.

d	 Programmable LEDs — one on each top corner can be programmed to provide 
system feedback. They light red or green and can blink or light steadily in response to 
user-defined events. These can be seen more clearly in the figure below.

e	 LCD screen — has a 800x480 resolution with a touch overlay. A graphical user 
interface, designed using the Extron GUI Configurator software, displays buttons, 
text, or icons on the screen (see page 24). These are configured for a range of user-
defined functions, using the Extron Global Configurator software (see page 29).

f	 Connection status LED — is unlit 
during normal operation. Blinks red if the 
connection to the IP Link controller is lost.

g	 Light sensor — (see the figure to the 
right) is on top of the display frame. The 
sensor monitors the level of ambient light 
and adjusts the screen brightness. The 
sensor can be viewed only from above 
the panel.

Extron
Extron

d

g

d
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TLP 710TV Rear Panel Features and Connections
The TLP 710TV has a stand that allows it to be placed on desktop. The stand can be 
removed to VESA mount the unit. Both the stand and the touchpanel have removable 
covers that conceal the rear panel features and protect cables that are attached to the 
TLP 710TV.

The rear and base covers can be removed using the Extron removal tool (provided) 
(see page 38).

14 15

11

13

8

9

10

12

Figure 9.	 TLP 710TV with the Stand and Cover Removed

The following features and connections are available through the back panel.

h	 Menu button — activates the on-screen menus for calibrating the unit (see 
page 14).

i	 Reset button — allows the unit to be reset in any of four different modes. For further 
information see “Reset Modes” on page 41.

j	 Reset LED — provides feedback about the reset status when the user presses the 
reset button. For further information see “Reset Modes” on page 41.
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k	 Power connector — Connect the 2-pole, 3.5 mm captive screw connector from the 
12 VDC, 1.0 A power supply (not provided) to the power supply socket on the rear 
panel. Ensure the connections have the correct polarity as shown in figure 10.

NOTES:

•	 Extron recommends using the Power over Ethernet power supply. 
The 12 VDC, 1.0 A power supply should only be used for setup or 
troubleshooting.

•	 If both power supplies are connected to the TLP 710TV, the PoE power 
supply takes precedence.

 

Power Receptacle

Captive Screw Connector

AC Power Cord

Ground  
+12 VDC 

External 
Power Supply
(12 VDC, 1 A )

SECTION  A–A

RidgesSmooth

Power Supply
Output Cord

AA

3/16"
(5 mm) Max.

Figure 10.	 Power Supply Connection

ATTENTION:	 See the Attention on page 7 for important information about 
power supplies.

NOTE:	 See the notes on page 7 for important information about wiring captive 
screw connectors.

l	 MTP signal adjustments — Three MTP signal adjustments are available for S-video 
luminance gain (VID/Y), S-video chrominance gain (C), and sharpness (S). For 
composite video signals, the gain is controlled by the VID/Y adjustment. Insert a small 
Phillips head screwdriver into the recess and turn clockwise to increase adjustment or 
counterclockwise to decrease.

m	 VESA mounting holes — Four holes are arranged in a pattern that is in accordance 
with the VESA FDMI standard, type D 75 mm (see Figure 9). See page 46 for more 
information about mounting the TLP 710TV with the Extron LPVM-1.
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n	 MTP input — A twisted pair cable, terminated with an RJ‑45 
connector, provides video and audio input from an Extron 
MTP transmitter. The MTP port is in the top surface of the 
recessed area (see the arrow to the left in figure 9).

CAUTION:	 Connect the MTP transmitter to the MTP socket and the network 
connector to the network socket. Although both use RJ-45 connectors, the 
MTP socket (on the left) must be connected to an MTP transmitter and the 
network socket (on the right) must be connected to a LAN. The wires on each 
connector use different voltages and inputting the wrong voltages into a socket 
will damage the TLP 710TV.

o	 Network LAN and Power over Ethernet Connector — The TLP 710TV connects 
to a network using a twisted pair cable, terminated with an RJ‑45 connector. The LAN 
port is in the top surface of the recessed area (see the arrow to the right in figure 9). 

The LAN port has two LEDs. The green LED lights steadily to indicate that the 
touchpanel is connected correctly to a network. The yellow LED flashes to indicate 
that data is being passed to or from the touchpanel.

An Extron IP Link control interface must also be connected to the same network 
domain. Suggested models are listed on page 3.

Use a straight-through Ethernet cable to connect the panel to a switch or router. Use 
a crossover cable to connect the panel directly to a computer.

Extron recommends using a Power over Ethernet (PoE) power supply. Use a 
straight‑through Ethernet cable to connect the power supply to a switch or router. 
This cable carries network information from the switch or router to the power 
supply input. A second straight-through cable carries the network information and 
48 VDC from the power supply to the TLP 710TV. Connect the IEC power cord to a 
convenient 100 VAC to 240 VAC, 50-60 Hz power source.

PWR LAN-OUT LAN-IN

To Network SwitchTo TLP 710TV

Power over Ethernet (PoE) Power Supply

Figure 11.	 Connecting the Power over Ethernet Power Supply

ATTENTION:	 See the Attention on page 8 for important information about 
using a Power over Ethernet power supply.

LAN

Activity LED

Link LED

RJ-45 Port
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NOTE:	 The twisted pair cable providing the MTP (Figure 9, n) and network 
LAN (Figure 9, o) connections should be secured together and to both the 
back panel and base using zip-ties as shown below.

LAN Connection

MTP Connection
Zip-tie

Zip-tie

Cable Runway

Figure 12.	 Connecting and Securing Cables
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Initial Calibration

This section describes:

•	 Accessing the Internal On-screen Menus

•	 Main Screen

•	 Volume Screen

•	 Time Screen

•	 Network Screen

•	 Video Screen

•	 Touch Calibration Screen

Accessing the Internal On-screen Menus
When the TouchLink panel first has power applied, the unit boots up and displays the 
opening screen. To access the on-screen menus, press the Menu button (see page 5 for 
the TLP 710MV or page 10 for the TLP 710TV).

The menus open at the Main screen. There are five different screens (Main, Volume, 
Time, Network, and Video) that can be selected by pressing the appropriate button at 
the left edge of the screen. 

There is also an Exit button at the bottom left corner of the screen. This button applies 
and saves any changes and closes the menu screens.

Main Screen

Main

Volume

Time

Network

Video

Exit

On

On

Down Up

Sleep timer: 300 Sec

Down Up

Backlight: 073%

Auto Backlight

Wake on Motion

PoE
Active

Figure 13.	Main Screen

Values can be changed by pressing the buttons to highlight them. Press the Down or Up 
buttons to adjust the values or toggle the Auto Backlight or Wake on Motion buttons 
between Off and On. When the function has a value (other than on or off), that value is 
shown above the buttons.
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The Sleep timer buttons determine how long the panel will be inactive before it enters 
Sleep mode, when the screen goes dark to save power. The time can be changed from 0 
to 50,000 seconds (in 10‑second increments). The time that is currently selected is shown 
above the buttons.

The screen may need a high level of backlighting for readability when ambient lighting is 
high. With low ambient lighting, the backlighting should be low.

Auto Backlight provides a suitable amount of backlighting that is automatically calculated 
from the amount of ambient light detected by the light detector.

When Auto Backlight is set to Off, the Backlight buttons allow the backlighting to be set 
manually from 0 to 100 percent.

NOTE:	 When Auto Backlight is set to On, the value of Backlight can be changed but 
this does not affect the amount of backlighting until Auto Backlight is inactivated.

Wake on Motion activates the panel from Sleep mode when motion is detected near the 
unit. Use the on-screen buttons to toggle the Auto Backlight or Wake on Motion options 
between Off and On.

Volume Screen

Exit

Master: 120

Click: 120

Sounds: 120

Down Up

Down Up

Down Up

Down Up

Line In: 120

Main

Volume

Time

Network

Video

Figure 14.	Volume Screen

Press the Down or Up buttons to highlight one of the adjustable audio features. Use the 
Down and Up buttons to adjust the following settings. 

•	 Master volume (between 0 and 255; default 120) sets the maximum volume for all 
the other sound volume settings. For example, if the master volume is set to 200 
(approximately 80 percent of maximum), even when the Line In volume is set to 255 
(maximum), it is equivalent to only 80 percent of maximum.

•	 Click (between 0 and 255; default 120) sets the volume for audible feedback that 
accompanies events such as a screen button being pressed.

•	 Sounds (between 0 and 255; default 120) sets the volume of audio from any audio file 
playback.

•	 Line In (between 0 and 255; default 120) sets the volume of the audio signal received 
through the line in from an Extron MTP transmitter.
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Time Screen

Exit

Down Up

Month: 06

Down Up

Hours: 13

Down Up

Day: 06

Down Up

Minutes: 32

Down Up

Year: 2011

Main

Volume

Time

Network

Video

Figure 15.	Time Screen

Use the Down or Up buttons to adjust the Month, Day, Year, Hours, and Minutes.

NOTE:	 The Hours value uses the 24‑hour clock. For 10 am, set hours to 10; for 
10 pm, set hours to 22.

Network Screen

Exit

Main

Volume

Time

Network

Video

IP Address

192.168.254.254

Subnet Mask

255.255.0.0

DHCP

Off

MAC: 00-05-A6-07-3A-55

1 2 3

4 5 6

7 8 9

0. Clear

Figure 16.	Network Screen

Select IP Address or Subnet Mask by pressing the appropriate button. When one of the 
buttons is selected, an on‑screen keypad appears that allows the user to select Clear, 
digits between 0 and 9, and “.” (dot).

NOTE:	 The factory default IP address for both the TLP 710MV and TLP 710TV is 
192.168.254.254. The default subnet mask is 255.255.0.0. Consult with your IT 
department to ensure these addresses are correctly assigned.

Toggle the DHCP button between On and Off to enable or disable Dynamic Host 
Configuration Protocol (DHCP). This determines whether the unit will have a permanent 
IP address or will have one provided by the network, when required. The default setting is 
Off.
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Video Screen

Exit

Main

Volume

Time

Network

Video

Down Up

Contrast: 064

Down Up

Color: 064

Down Up

Brightness: 128

Down Up

Tint: 128

Figure 17.	Video Screen

The small gray rectangle provides a video preview window for adjusting video properties.

Use the Down or Up buttons to adjust:

•	 Contrast between 0 and 127 (default, 64)

•	 Color between 0 and 127 (default, 64)

•	 Brightness between 0 and 255 (default, 128)

•	 Tint between 0 and 255 (default, 128)

Touch Calibration Screen
After setting the values, press the Menu button a second time to calibrate the touch area 
of the Touchpanel.

++

++

Press and Hold
Highlighted Box

Until Color Changes

Figure 18.	Touch Calibration Screen

Press on the green box until the color reverts to gray with a white border and a second 
box is highlighted. Repeat until all four boxes have been pressed and calibrated. At that 
point the screen returns to the Main screen (see page 14).

Exit the on-screen menus, by pressing the Exit button in the bottom left corner of the 
menu screens.
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Configuration 
Software

This section of the user guide provides information about:

•	 The Configuration Software

•	 Installing the Software

•	 Using the TouchLink Panel Web Pages

•	 Updating the Firmware

•	 Using GUI Configurator

•	 Using Global Configurator

The Configuration Software
Designing a graphical user interface (GUI) for the TouchLink panel takes two steps:

1.	 Design the layout of the text and graphics using GUI Configurator.

2.	 Assign functions to the text and graphics using Global Configurator.

The GUI Configurator software is a Windows-based application. The TLP interface 
is designed either by customizing an existing template or by creating an entirely new 
interface. GUI Configurator offers several templates.

After the GUI has been designed on a PC, the project is saved, built, and uploaded to 
the TouchLink panel to verify what it looks like on the screen. It is then imported from 
the TLP unit to Global Configurator where control functions are assigned to the text and 
graphic items in the layout. After assigning the control functions, the project is rebuilt and 
uploaded to the controller.

The GUI Configurator and Global Configurator programs provide versatility and 
adaptability for configuration and control of an AV system as it grows and evolves.

Installing the Software

Installing GUI Configurator and Global Configurator

NOTE:	 Use Global Configurator 3.3 or a later version and GUI Configurator 1.3 or a 
later version to configure the TLP 710MV or TLP 710TV.

Insert the provided disc into the DVD drive of the computer. If the setup program does not 
start automatically, run Launch.exe from the DVD directory in Windows My Computer. 
Select the Software tab, locate the GUI Configurator program, and click Install. Follow 
the on-screen instructions. 

By default, the Installer program creates and places the GUI Configurator program in 
the C:\Program Files\Extron\GUI Configurator folder. An icon may also be 
placed on the Windows desktop.
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If required, locate the Global Configurator program on the disc or website and install that 
also. By default, the Installer program creates and places the Global Configurator program 
in the C:\Program Files\Extron\GCx.x folder, where x.x represents the version of the 
Global Configurator program. During installation, there is an option to place an icon on the 
Windows desktop.

Both programs can be downloaded from the Extron website (www.extron.com). Select 
the Download tab and click the Software option in the sidebar at the left. Navigate to GUI 
Configurator or Global Configurator and click Download next to the program. Follow the 
on‑screen instructions to complete installation. A folder is created on the C:\ drive and an 
icon may be placed on the desktop.

Using the TouchLink Panel Web Pages
Both of the TouchLink panels have default web pages that can be used to read and 
change the current settings of the panels. The web pages can be accessed as follows:

1.	 Open your browser and type the IP address of the TLP 710 unit into the address 
field. The browser opens the TouchLink panel Status page, which is read-only and 
provides basic information about the model, date and time, and IP settings.

Figure 19.	 System Status Page
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2.	 Click the Configuration tab and then click System Settings in the menu in the 
left sidebar. This page allows the user to modify the IP settings and the date and time 
settings. These correspond to the Network Screen (see page 16) and Time Screen 
(see page 16) settings in the on‑screen menus.

Figure 20.	 System Settings Page

3.	 Click Passwords in the menu in the left sidebar. This page allows the user to set 
passwords for an administrator and a user. To set a password, follow the instructions 
at the top of the page. 

Figure 21.	 Passwords Page
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4.	 To upgrade the firmware, select Firmware Upgrade. For more detailed instructions, 
see Updating Firmware from a Web Browser on page 23.

5.	 Click the Touchpanel tab to access the Touchpanel Configuration page, which allows 
the user to alter the touchpanel and volume settings. These correspond to the Main 
settings (see page 14) and Volume settings (see page 15) in the on-screen menus.

Figure 22.	 Touchpanel Configuration Page

Updating the Firmware
Firmware for both touchpanels can be upgraded using the Extron Firmware Loader, 
using the TLP 710 default web page, or using GUI Configurator. Before starting, 
consult your IT team and ensure that the touchpanel has a unique IP address.

Updating Firmware Using Extron Firmware Loader
1.	 Power on a computer that is connected to the same network as the touchpanel.

2.	 Install the Extron Firmware Loader utility onto the computer if it is not already present. 
This is on the software disc that ships with unit or can be downloaded, free of charge, 
from the Extron website (www.extron.com).

To install from the disc, insert the disc into the DVD drive of the computer and follow 
the same procedure as Installing GUI Configurator and Global Configurator (see 
page 18).

To install from the Extron website (www.extron.com), select the Download tab and 
then the Software tab. Locate the Firmware Loader and click Download. Follow the 
on-screen instructions to complete installation.
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3.	 Also from the Extron Download page, download the firmware for the TouchLink 
panel. Click the Firmware link on the left sidebar.

Figure 23.	 Extron Web Page — Download Center

4.	 Navigate to the TLP 710MV or TLP 710TV firmware and click Download.

This downloads the firmware to your computer. Note the folder in which the firmware 
file is saved.

5.	 Open the Extron Firmware Loader by clicking on the desktop icon.

6.	 Select TLP 710MV or TLP 710TV from the Device drop-down menu.

7.	 Select TCP/IP from the Connection Method drop-down menu.

8.	 Enter the IP address for the TLP 710, a Telnet port number (usually 23), and a 
password. 

9.	 In the New Firmware File “Path” pane, navigate to the file that was saved in step 4. 
Click the Add button. The main Firmware Loader screen opens with the TLP 710MV 
or TLP 710TV listed in the device pane.

10.	Click Begin. The firmware transfer begins and takes approximately three minutes. 
When the Total Progress box shows “Completed,” select Exit from the File menu to 
exit Firmware Loader.
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Updating Firmware Using GUI Configurator
Set up the computer and touchpanel as described in steps 1 and 2 in the previous 
section (Updating Firmware Using Extron Firmware Loader). If necessary, install the 
Extron Firmware Loader utility onto the computer (see Installing the Software).

1.	 Find the firmware file on the Extron Website and download it to your computer, as 
described in steps 3 and 4 in the previous section.

2.	 Open GUI Configurator.

3.	 Select Firmware Update Manager... in the Tools menu. Firmware Loader opens.

Figure 24.	 Opening Firmware Loader from GUI Configurator

4.	 Follow steps 7 through 10 in the previous section (Updating Firmware Using 
Extron Firmware Loader).
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Updating Firmware from a Web Browser
1.	 Power on a computer that is connected to the same network as the TLP 710.

2.	 From the Extron website (www.extron.com), download the firmware for the 
touchpanel.

a.	 Click the Download tab on the Extron home page

b.	 Select the Firmware option (see figure 23).

c.	 Navigate to the touchpanel firmware and click Download.

This downloads the firmware to your computer. Note the folder in which the firmware 
file is saved.

3.	 In the address field of your browser, type the IP address of the TLP 710 unit. The 
browser opens the TouchLink panel web pages (see page 19).

1

2

3 4

Figure 25.	 Firmware Upgrade Web Page

4.	 Click the Configuration tab (Figure 25, a) at the top of the page and then select 
Firmware Upgrade (Figure 25, b) from the sidebar on the left.

5.	 Click the Browse button (Figure 25, c) and navigate to the firmware file that was 
saved in step 2.

6.	 Click Upload (Figure 25, d). The Touchpanel screen shows the message “Firmware 
Uploading... Please Wait...”. When the firmware is uploaded, the screen shows the 
message “Restarting...”. Once the firmware is installed, the panel can be calibrated 
using the on‑screen menus (see page 14) or the TouchLink panel web pages 
(see page 19).
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Using GUI Configurator
This section provides an overview of the GUI Configurator program. For complete 
information about the program, see the GUI Configurator help file (select Contents from 
the Help menu or press the <F1> key while the program is running).

NOTE:	 To configure the touchpanel, use GUI Configurator version 1.3 or later.

To use the GUI Configurator program, follow these instructions:

1.	 Double click the desktop icon. A splash screen appears momentarily and then the 
program opens at the main screen behind the GUI Configurator Start Options dialog 
box.

Figure 26.	 Opening GUI Configurator

Figure 27.	 GUI Configurator Start Options Dialog Box
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2.	 Choose from the following options:

•	 Start a New Project — Clicking OK opens a dialog box that offers a choice of 
project options.

Figure 28.	GUI Configurator New Project Dialog Box

A series of icons offers the choice of creating a project with or without a template 
and allows the size and type of Touchlink panel to be selected. To work from a 
template, users can choose from a range of factory-loaded templates or from a 
template they have previously created.

•	 Open an Existing Project — Clicking OK opens a dialog box.

Figure 29.	GUI Configurator Dialog Box to Open an Existing Project

a.	 Navigate to the existing file and select it. To look at a project without altering 
it, ensure the Open as read-only box is checked.

b.	 Click Open to open the file. The project opens in GUI Configurator.
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•	 Download an Existing Project from a Panel — Clicking OK opens a 
dialog box that allows a file that has already been uploaded to a touchpanel to be 
downloaded for modification.

Figure 30.	GUI Configurator Download Project Dialog Box

a.	 In the dialog box that opens, enter the IP address of the panel and use the 
Browse button to navigate to a folder where the file will be saved.

b.	 Check Open the project and Close Download Manager.

c.	 Click OK. The project is downloaded to your computer and opens in 
GUI Configurator.
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3.	 Depending on which option was selected in step 2, GUI Configurator opens a new or 
existing project. The initial screen is divided into a series of panes offering a range of 
tools that can be used to design or modify the project. For full details on how to use 
these tools, see the help file (from the Help menu select Contents or press the <F1> 
key while the program is running).

 

Figure 31.	 GUI Configurator Main Screen

4.	 To save the project, select Save Project from the File menu. If this is the first time 
saving the project file, the Save As dialog box appears. If the Save As dialog box 
appears:

a.	 Browse for the location where the project file is to be saved.

b.	 Enter a file name for the project.

c.	 Click Save.
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5.	 The project can be uploaded to one or more TouchLink panels. To add a panel:

a.	 From the Project menu, select Add > Panel. The Panel Manager dialog box 
opens:

Figure 32.	Add a TouchLink Panel (b)

b.	 In the Panel Manager dialog box, click the Add Panel icon (see the 
illustration to the right) to add a new panel to the left pane.

c.	 Highlight the name of the panel in the left pane to display the 
properties of that panel in the right pane.

d.	 When a new panel is added, it is assigned the default IP address 
(192.168.254.254). To change the IP address, highlight the address property in 
the right pane and type in the correct IP address. Update any other properties, as 
required.

e.	 Repeat steps 5b - 5d to add further panels, if required.

f.	 Close the Panel Manager dialog box.

6.	 Upload a project to a TouchLink panel as follows:

a.	 Highlight a panel in the Properties window on the left side of the GUI Configurator 
screen

b.	 From the Project menu, select Upload to Selected Panels. The Build 
Manager dialog box opens, showing the build progress. After the build is 
complete, this dialog box closes and the File Upload Manager screen opens. The 
upload begins automatically.

c.	 Select Close this dialog when upload completes check box in the 
Automatic Settings section so that the File Upload Manager screen closes 
automatically when the upload completes. This option can be set before or during 
the upload.

If this project has been uploaded to the TouchLink panel before, the user can upload 
only the changes that have been made to the previous version. The project can 
be uploaded to certain touchpanels selected from the list found within the Devices 
section of the File Upload Manager screen. 
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Using Global Configurator

NOTE:	 To configure the touchpanel, use Global Configurator version 3.3 or later.

This section provides an overview of the Global Configurator program. For complete 
information about the program, see the Global Configurator help file (select Contents 
from the Help menu or press the <F1> key while the program is running).

NOTE:	 This section describes how to set up Global Configurator project with an 
IPL 250. While setting up a project with another IP Link product is similar, see the 
Global Configurator help file for exact information about the product being used.

1.	 Double-click the GC3 desktop icon. The Global Configurator 3 Start Options box 
opens.

 

Figure 33.	 Global Configurator 3 Start Options
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2.	 Select Create A New Project and click OK. The dialog box closes and the Project 
Settings dialog box opens.

Figure 34.	 Global Configurator Project Settings

3.	 Enter the IP address for the IP Link controller.

•	 The default Telnet connection is port 23 and the default HTTP connection is port 
80. These values do not usually need to be changed.

•	 If necessary, set administrator and user passwords.

•	 If required, set the date and time.

•	 Checking the Set Device as GlobalViewer Host box is optional. For more 
information about GlobalViewer host, see the Global Configurator help file.
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4.	 Click OK. The Project Settings dialog box closes and is replaced by the Add Device 
dialog box:

Figure 35.	 Global Configurator Add Device Dialog Box

5.	 Add a device to your project as follows:

a.	 To see all the options, click the Advanced >>> button. The button name changes 
to Basic <<< (as shown in the figure above).

b.	 Select the IP Link device from the drop-down menu. In figure 36, above, an 
IPL 250 controller is added. Adding a different IP Link product is similar.

c.	 Enter the IP address of the IP Link controller. The default value is 
192.168.254.254, but this may have been changed. Check with your IT 
department to verify the address.

d.	 Enter a display name into the text box. This is what the device will be known as in 
the Global Configurator project.

e.	 Checking the Make this device a GlobalViewer Host check box is optional.

f.	 Set the Telnet port (usually 23) and the web port (usually 80).

g.	 If the controller is password protected, enter the password into the Admin 
Password or User Password field.

h.	 In the right pane, set up a GlobalViewer tree. For information about this, see the 
Global Configurator help file.
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6.	 Click OK. The Add Device dialog box closes. The start-up screen, which was behind 
it, is now visible, showing the IPL 250 and the available ports:

Figure 36.	 Configuring an IP Link Device

7.	 Select TouchPanel Port 1. The screen shows the available options for the 
TouchLink panel. 

8.	 Click Click here to add one.

Figure 37.	 Adding a TouchLink Panel
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9.	 On the Add TouchPanel dialog box, do the following:

Figure 38.	 Add TouchPanel Dialog Box

a.	 Ensure the correct TouchLink panel model is selected from the drop-down menu 
and enter the IP address.

b.	 Set the Telnet port (usually 23) and, if necessary, enter the password.

c.	 Check the Import/Apply Layout check box and click OK.

The window now shows the GUI from the TouchLink panel.

Figure 39.	 Touchpanel GUI Loaded Onto Global Configurator 3

10.	Use Global Configurator to associate functions with the screen elements designed in 
GUI Configurator (see the Global Configurator help file).

11.	Save the configuration and upload it to the controller.
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Mounting

This section outlines the various options for:

•	 Rack Mounting the TLP 710MV

•	 Wall Mounting the TLP 710MV

•	 Furniture Mounting the TLP 710MV

•	 Wall Mounting the TLP 710MV with a Wallbox

•	 Desktop Mounting the TLP 710TV

•	 Removing the TLP 710TV base for VESA Mounting

•	 VESA mounting the TLP 710TV

Rack Mounting the TLP 710MV

Underwriters Laboratories Guidelines for Rack Mounting
The following Underwriters Laboratories (UL) guidelines are relevant to the safe installation 
of these products in a rack:

Elevated operating ambient temperature — If the unit is installed in a closed or 
multi-unit rack assembly, the operating ambient temperature of the rack environment 
may be greater than room ambient temperature. Therefore, install the equipment in an 
environment compatible with the maximum ambient temperature (Tma: +122 °F, +50 °C) 
specified by Extron.

Reduced air flow — Install the equipment in the rack so that the equipment gets 
adequate air flow for safe operation.

Mechanical loading — Mount the equipment in the rack so that uneven mechanical 
loading does not create a hazardous condition.

Circuit overloading — Connect the equipment to the supply circuit and consider the 
effect that circuit overloading might have on overcurrent protection and supply wiring. 
Give appropriate consideration to the equipment nameplate ratings when addressing this 
concern.

Reliable earthing (grounding) — Maintain reliable grounding of rack-mounted 
equipment. Pay particular attention to supply connections other than direct connections 
to the branch circuit (such as the use of power strips).

Rack Mounting the TLP 710MV
The TLP 710MV can be mounted in any standard 19-inch equipment rack, using the 
optional Extron RM 710M rack mounting kit. Follow the instructions provided with the kit.
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Wall Mounting the TLP 710MV
The following steps show how to wall-mount theTLP 710MV. Furniture-mounting is similar.

1.	 Determine the best location for the TLP 710MV.

2.	 Use the template provided to mark the wall and cut a hole 7.5 inches (19.05 cm) wide 
by 5.813 inches (14.76 cm) high.

3.	 Remove the bezel, using the Extron removal tool.

4.	 Ensure that all the locking arms are flush with the unit and check that the TLP 710MV 
can fit into the hole. If necessary, use a rasp or a coarse file to enlarge the hole.

5.	 Run the network and video cables inside the wall to the hole, leaving enough slack in 
the cables to connect them to the back of the TLP 710MV.

6.	 Plug the cables into the rear panel connectors (see pages 6 - 8).

•	 Connect the LAN port to the network with a straight-through cable, providing 
both a network connection and power from a PoE power supply.

•	 Connect an S-video or composite video source to the RJ-45 MTP input.

•	 Optional: Extron recommends using the PoE power supply provided. However, 
the LAN port may be used as a network-only connection. Connect a 12 VDC, 
1.0 A power supply (not provided) to the 2-pole captive screw power input. See 
the Attention on page 7 for very important information about power supplies.

7.	 Push excess cables into the wall cavity.

8.	 Ensure the four locking arms (two at the top and two at the bottom) are flush with top 
and bottom of the TLP 710MV and fit the touchpanel into the hole.

9.	 Use a Phillips head screwdriver to tighten the locking arm screws. As the screws 
tighten, the locking arms rotate into position behind the wall and hold the unit in 
place. Do not overtighten the screws as this can damage the locking arms or the wall.

Bezel snaps to unit
(2 tabs on each side).

Tighten screws to
rotate locking arms.

Locking arm (4)

Figure 40.	 Secure the TLP 710MV to a Wall with Locking Arms

10.	If required, perform the initial calibration (see page 14).

11.	Replace the bezel by pressing the catches on the bezel into the corresponding holes 
on the front of the panel. 
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Furniture Mounting the TLP 710MV
The TLP 710MV can be mounted into the surface of a lectern as follows:

1.	 Determine the best location for the TLP 710MV.

2.	 Use the template provided to mark the lectern and cut a hole 7.5 inches (19.05 cm) 
wide by 5.813 inches (14.76 cm) high.

3.	 Remove the bezel from the TLP 710MV.

4.	 Ensure all the locking arms are flush with the unit and check that the TLP 710MV can 
fit into the hole. If necessary, use a rasp or a coarse file to enlarge the hole.

5.	 With the TLP 710MV in position, mark four holes for the screws that will secure the 
unit to the lectern.

6.	 Remove the TLP 710MV and, if necessary, drill four pilot holes into the lectern.

7.	 Run the network and video cables to the lectern and through the mounting hole, 
leaving enough slack to connect them to the back of the TLP 710MV.

8.	 Plug the cables into the rear panel connectors (see pages 6 and 7).

Connect the LAN port to the network with a straight-through cable, providing both a 
network connection and power from a Power over Ethernet power supply.

Connect an S-video or composite video source to the RJ-45 MTP input.

Optional: Extron recommends using the Power over Ethernet power supply provided. 
However, the LAN port may be used as a network-only connection. Connect a 
12 VDC, 1.0 A power supply (not provided) to the 2-pole captive screw power input. 
See the Attention on page 7 for very important information about power supplies.

9.	 Push excess cable into the lectern.

10.	Ensure the four locking arms (two at the top and two at the bottom) are flush with top 
and bottom of the TLP 710MV and fit the touchpanel into the hole.

11.	Secure the touchpanel to the lectern with four #4 screws (not provided), using the 
pilot holes drilled in step 6.

12.	Replace the bezel by pressing the catches on the bezel into the corresponding holes 
on the front of the panel.

Bezel snaps to unit
(2 tabs on each side).

Secure unit with
mounting screws (4).

Drill holes for
mounting screws (4).

Cut hole for
mounting unit.

Figure 41.	 Mounting the TLP 710MV on a Lectern
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Wall Mounting the TLP 710MV with a Wall Box
The TLP 710MV can be wall mounted using the Extron BB 710M or the Extron 
EWB 710M. Follow the instructions provided with the appropriate wall box.

Desktop Mounting the TLP 710TV

Placement without a Mounting Kit
The TLP 710TV comes assembled with a stand that allows it to be placed on a desktop.

To secure the unit to the desktop:

Mounting Holes (2)

Figure 42.	TLP 710TV Base (Bottom View), Showing Mounting Holes

1.	 Mark the location of two holes, 3.07 inches (78 mm) apart.

2.	 Drill two holes through the desktop from underneath.

3.	 Attach the TLP 710TV, using two #8 wood screws through the desktop from 
underneath into the two holes in the base. 

Placement with a Kensington Security Lock

Kensington Security Slot

Figure 43.	 TLP 710TV Base, Showing Kensington Security Slot

For additional security, the rear edge of the base has a metal-reinforced slot, which may 
be used to attach a Kensington Security Lock (not provided). Follow the instructions that 
are provided by the manufacturer to install the lock.
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Mounting with a Swivel Mount Adapter
The TLP 710TV can be mounted with the optional Extron SMA-1 swivel mount adapter. 
This allows the unit to be mounted permanently yet swivel up to 180° in either direction.

1.	 Remove the back cover and base cover, using the provided Extron removal tool, as 
described in “Removing the TLP 710TV Base for VESA Mounting“ on the next 
page.

2.	 Remove the screw holding the locking plate at the bottom of the base. This releases 
the weight, which can be removed from the top of the base, leaving the mounting 
hole that will fit over the conduit of the SMA-1.

Locking ScrewLocking Plate

Figure 44.	 TLP 710TV Base, Showing Locking Plate and Screw

3.	 Attach the conduit, insulation disk, and swivel disk and configure the set screws to 
allow for the degree of swivel that is required (see the SMA-1 Swivel Mount Adapter 
Kit User Guide, available at www.extron.com).

4.	 Place the mounting hole in the base over the conduit of the SMA-1.

5.	 Secure the unit with the backing plate and locking nut as described in the SMA-1 
Swivel Mount Adapter Kit User Guide.

Removing the TLP 710TV Base for VESA Mounting

Notch to Remove
Base Cover

Notch to Remove
Back Cover

Figure 45.	Removing the Back and Base Covers

1.	 Remove the back cover by inserting the Extron removal tool (provided) into the 
notches on each side and prying off the cover.

2.	 Remove the base cover using the Extron removal tool.
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VESA Mounting Holes (4)

Hinges (2)

Cable Runway

Spanner Drive
Security Screws
(2 for each hinge)

Figure 46.	Removing the Base from the Touchpanel

3.	 If necessary, cut the zip tie holding the twisted pair cables to the TLP 710TV base.

4.	 If necessary, remove the cables from the cable runway in the base.

5.	 Remove the four spanner drive security screws holding the hinges to the touchpanel.

NOTE:	 The spanner drive screws holding the hinges require a #6 spanner bit or 
#6 spanner head screwdriver, which is not provided.

6.	 Lift the TLP away from the base. 
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VESA Mounting the TLP 710TV
1.	 Before attaching the VESA mounting kit, remove the base and back of the 

TLP 710TV, as described in the previous section.

2.	 If necessary, connect the cables and use a zip tie to secure them to the back of the 
touchpanel.

3.	 Attach the small back cover (provided). Fit the bottom catches into the slots on the 
bottom of the panel and snap the side catches into place. 

4.	 Secure a VESA D 75 mm mount kit to the back of the TLP 710TV. Follow the 
instructions provided with the mounting kit. Figure 47, below, shows the Extron 
LPVM-1 mount kit.

LPVM-1 Plate 2

Security Screws (4)

Small Back Cover

Figure 47.	 VESA Mounting the TLP 710TV with the LPVM-1
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Reset Modes

The TLP 710MV and TLP 710TV have four reset modes that correspond to four of the 
five reset modes for the IP Link controllers. The modes are initiated by pressing the Reset 
button.

To access the Reset button on the TLP 710MV, remove the bezel. See page 5 to locate 
the Reset button on the TLP 710MV. The Reset button on the TLP 710TV is on the 
back panel. See page 10 to locate the Reset button on the TLP 710TV.

TLP 710 MV and TLP 710TV Reset Mode Summary
Mode Activation Result Purpose and Notes

U
se

 F
ac

to
ry

 F
ir

m
w

ar
e 1 Hold down the Reset button while 

applying power to the TLP 710.

NOTE:	 After a mode 1 reset is 
performed, update the TLP 710 
firmware to the latest version. 
Do not operate the firmware 
version that results from this 
mode reset. To use the factory 
default firmware, reload that 
version. See page 21 for details 
about uploading firmware.

The TLP 710 reverts to the factory default 
firmware. Event scripting does not start if the 
TLP 710 is powered on in this mode. All user files 
and settings (GUI, adjustments, IP settings) are 
maintained.

NOTE:	 If you do not want to update firmware or 
you performed a mode 1 reset by mistake, 
cycle power to the TLP 710 to return to the 
firmware version that was running before the 
mode 1 reset. 

This mode reverts to the 
factory default firmware 
version if incompatibility 
issues arise with 
user‑loaded firmware.

NOTE:	 User‑defined 
web pages may 
not work correctly 
with an earlier 
version of the 
firmware.
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E
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s

3 Hold down the Reset button for 
approximately 3 seconds until the 
Reset LED blinks once. Then release 
and press Reset momentarily (less 
than 1 second) within 1 second.

This mode turns events on or off.

NOTE:	 Nothing happens if the momentary 
press does not occur within 1 second.

This mode is useful for 
troubleshooting.

R
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ll 
IP

 S
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ng

s 4 Hold down the Reset button for 
approximately 6 seconds until the 
Reset LED blinks twice (at 3 seconds 
and 6 seconds). Then release and 
press Reset momentarily (less than 
1 second) within 1 second.

NOTE:	 Nothing happens if the 
momentary press does not 
occur within 1 second.

This mode:
•	Enables ARP capability.
•	Resets the IP address to the factory default 

(192.168.254.254).
•	Resets the subnet to the factory default.
•	Resets the gateway address to the factory 

default.
•	Turns DHCP off.

This mode enables 
you to set IP address 
information, using ARP 
and the MAC address.
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5 Hold down the Reset button for 
approximately 9 seconds until the 
Reset LED blinks three times (at 3, 
6, and 9 seconds). Then release and 
press Reset momentarily (less than 
1 second) within 1 second.

NOTE:	 Nothing happens if the 
momentary press does not 
occur within 1 second.

This mode performs a complete reset to factory 
defaults (except the firmware). It does everything 
that mode 4 does and, in addition:
•	Removes button and touchpanel 

configurations.
•	Resets all IP options
•	Removes all scheduling options.
•	Removes and clears all files from the TLP 710.

This mode is useful 
to start over with 
configuration and 
uploading.
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Extron Headquarters
+1.800.633.9876 (Inside USA/Canada Only)

Extron USA - West	 Extron USA - East 
+1.714.491.1500	 +1.919.850.1000 
+1.714.491.1517 FAX	 +1.919.850.1001 FAX

Extron Europe
+800.3987.6673 
(Inside Europe Only)

+31.33.453.4040 
+31.33.453.4050 FAX

Extron Asia
+65.6383.4400
+65.6383.4664 FAX

Extron Japan
+81.3.3511.7655
+81.3.3511.7656 FAX

Extron China
+86.21.3760.1568 
+86.21.3760.1566 FAX

Extron Middle East
+971.4.299.1800
+971.4.299.1880 FAX

Extron Korea
+82.2.3444.1571
+82.2.3444.1575 FAX

Extron India
1800.3070.3777 
(Inside India Only)

+91.80.3055.3777 
+91.80.3055.3737 FAX

© 2013 Extron Electronics   All rights reserved.   www.extron.com

Extron Warranty
Extron Electronics warrants this product against defects in materials and workmanship for a period of three 
years from the date of purchase. In the event of malfunction during the warranty period attributable directly to 
faulty workmanship and/or materials, Extron Electronics will, at its option, repair or replace said products or 
components, to whatever extent it shall deem necessary to restore said product to proper operating condition, 
provided that it is returned within the warranty period, with proof of purchase and description of malfunction to:

USA, Canada, South America, 
and Central America: 
Extron Electronics 
1230 South Lewis Street 
Anaheim, CA 92805 
U.S.A.

 
Japan: 
Extron Electronics, Japan 
Kyodo Building, 16 Ichibancho 
Chiyoda-ku, Tokyo 102-0082 
Japan

Europe and Africa: 
Extron Europe 
Hanzeboulevard 10 
3825 PH Amersfoort 
The Netherlands

China: 
Extron China 
686 Ronghua Road 
Songjiang District 
Shanghai 201611 
China

Asia: 
Extron Electronics Asia Pte. Ltd. 
135 Joo Seng Road, #04-01 
PM Industrial Bldg. 
Singapore 368363 
Singapore

Middle East: 
Extron Middle East 
Dubai Airport Free Zone 
F12, PO Box 293666 
United Arab Emirates, Dubai

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical 
or mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not 
authorized by Extron.

NOTE:	 If a product is defective, please call Extron and ask for an Application Engineer to receive an RA 
(Return Authorization) number. This will begin the repair process. 
 
USA:	 714.491.1500 or 800.633.9876	 Europe:	 31.33.453.4040  
Asia:	 65.6383.4400	 Japan:	 81.3.3511.7655 

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or 
damage during shipment. Returned units must include the serial number and a description of the problem, as 
well as the name of the person to contact in case there are any questions. 

Extron Electronics makes no further warranties either expressed or implied with respect to the product and its 
quality, performance, merchantability, or fitness for any particular use. In no event will Extron Electronics be liable 
for direct, indirect, or consequential damages resulting from any defect in this product even if Extron Electronics 
has been advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty 
may not apply to you.
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